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Overview 
 

DKVBrowser, developed by Kevin Goroway, is an application that can be used instead of the PDA (PRC-

100) or Tablet or Virtual PRC-100 that is normally supplied with a Yamaha Disklavier Mark IV.   It can be 

downloaded from sourceforge.net by searching for DKVBrowser.  There are Mac and PC versions built 

and ready to run, but it can run on any platform that supports Java and can access the Disklavier either 

wired or wirelessly.  It is licensed under GNU General Public License.   

 

Features 

• Displays playlists and albums and the songs contained in them as an easy to understand tree view.  

• Allows searching of songs stored on the Mark IV Disklavier hard drive. You can search by title  

(album or song), rating, comments, file name, or any combination of the above. 

• Plays songs selected from search or a playlist or album or source.  Option to play randomly from 

album or an entire source is available. 

• Allows editing a song’s title, comments, or rating, and album titles in ‘Source’ view or ‘Details’ view.  

(Note:  the F2 key is used for editing song names and album names in the source view).   Note: 

editing can be done while piano is in standby mode on non-removable source views. 

• Allows Drag and Drop operations for moving or copying a song to a playlist or album, deleting a 

song from a playlist or album, and reordering of songs within a playlist or album.  Allows reordering 

albums within a source list.   (Note:  Mac users – option key needed for copy, without holding 

down option key a move is performed, on the PC the control key is required). 

• Allows creating a new playlist, deleting a playlist, renaming and reordering playlists. 

• Provides an exported report of all albums and songs stored on the Mark IV Disklavier hard drive.  

Data is stored in spreadsheet format. (Export format).  Also able to export search results. 

• Repeat play a section of a Midi song, an entire song or entire album.  

• Allows user to customize and save “perspectives” (positional layouts) for windows such as 

‘Source’, ‘Now Playing’, ‘Search’, ‘Playlists’, ‘Details’, ‘Repeat’, ‘A/B Repeat’, ‘Volume’ and 

‘Volume Details’, ‘Song Options’ and ‘Metronome’.  These windows have minimize, maximize and 

delete options as well as drag and drop placement and tear-off options.   

• Allows option to drag and drop songs and albums into and out of the To/From PC tab (‘PC’) 

directly from/to the user’s hard drive. 

• Allows drag and drop of songs to a playlist in the order desired. 

• Allows drag and drop of albums and songs from any source (where appropriate) to another 

source via move or copy.  (For example, you can move or copy songs/albums from PC tab to User tab 

using drag and drop.) 

• Allows option to refresh PC tab from edit menu, or context menu on the ‘PC’ tab.   

• Allows auto-pausing (including auto-restart), if selected in Preference Window. 

• Allows setting song options such as Piano Parts (L & R), Piano Velocity Curve, Main Volume 

Adjustment, Audio Volume & Pitch Adjustments, Skip and Guide for SmartKey Function. 

• Allows the user to create a playlist from search results. 

• Allows the user to collapse and expand the albums/playlists to view the songs within albums and 

playlists. 

 

Many of the above functions duplicate what is allowed on the PRC-100, or tablet, or Virtual PRC.  

However, in most cases DKVBrowser offers a very convenient interface.  For example, when editing titles, 

you have a larger screen and a real keyboard to use for editing purposes.  When creating playlists or 

reordering songs or albums, you can use drag and drop.  Note: whenever possible, the piano’s software is 

used to perform the functions, such as copy.  DKVBrowser is a very convenient user interface.   It does not 

try to replicate all the PRC-100 functions.  It specializes in tasks that require a keyboard and screen real 
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estate, such as editing data.  The auto-pause feature of DKVBrowser allows the user to automatically 

pause a song that is playing, while the user performs operations which otherwise would cause the piano to 

tell her that she needs to stop the playing manually.  When the operation is complete, DKVBrowser 

instructs the piano to start playing again from the position where the song was paused.  

DKVBrowser is still undergoing development and testing.  Use at your own risk.  DKVBrowser requires 

your Mark IV Disklavier to be running version 2.10 or greater of the Disklavier software. 

 

The original idea for this program came from code by Matthew Teeter 

(http://music.arts.uci.edu/dobrian/disklavier/).   

 

Support and discussions about DKVBrowser take place on the yahoo “group” for DKVBrowser 

(http://launch.groups.yahoo.com/group/dkvbrowser/) .  

 

 

Hardware Requirements 
 

DKVBrowser can run on any computer on the network with a Disklavier Mark IV, and the appropriate 

‘swt.jar’ java library.  This document will show screens from a PC running Windows XP and Mac OSX 

Leopard.   The sourceforge site also has a screen shot of DKVBrowser running on Ubuntu, a Linux-based 

operating system. 
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Using DKVBrowser  
 

General 

Note:  Fast clicking and random clicking is NOT RECOMMENDED.  The program has to pass the 

command to the piano, and in most cases, a function has to be performed on the piano.  Occasionally the 

program will crash just as the PRC-100 does.  Just quit the application and relaunch it. 

 

Perspective (Initial Screen Mode) - default 

The initial screen or perspective window will look similar to the image below.  On a PC, the will be 

replaced with  ‘+’ to indicate a list that can be expanded to display the songs in the album.  It is 

recommended that you maximize the window, or enlarge it significantly, after launching the program. 

Unless you exit abnormally, this size will be remembered the next time you invoke the program.  The status 

bar at the bottom of the DKVBrowser window indicates piano status.  On the left, the song that is 

currently selected in the source view is displayed giving the source tab, album title and song title.  On the 

right, the indicator for the current status of the piano (playing or stopped) and time of day is displayed. 
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Source View  

The Source View represented by tabs shows the lists of albums and songs.  The source tabs include:  all, 

pianosoft, user, cd library, store, use, cd, floppy, and PC.  Some functions are limited to certain tabs.  In 

particular, most functions are allowed on the pianosoft and user tabs, because they are stored on the piano’s 

hard disk and will always be available.  In all cases, the icon in front of the album indicates what source 

contains that album.  This is most useful in the ‘all’ tab.  (Note:  Copying of pianosoft disks will generally 

be prohibited by the piano’s software, but DKVBrowser will allow you to initiate the copy, and then tell 

you the copy failed.)  The tabs in the source view cannot be reordered. 

 
On the left side in the middle of the perspective or main window, you will see a series of tabs for the 

various sources.  All is the default.  Icons are used to indicate the source within the all list.  The icons are 

also shown on their corresponding tabs to the left of the source name. 

 

Next to each album title is the number of songs in brackets. [ ] 

Clicking on the various source tabs, will bring up the albums for that source.  To view the songs under 

each album, click on the ‘+’ (PC Version) or   (Mac Version) or double click on the album title.   This 

view also allows the user to see comments, ratings and filenames for the songs in the source tab (see 

example below). Double-clicking on the song title will activate playing of that song. When that song is 

completed the next song in the album will begin until all songs are played or stopped.   Note:  Right 

clicking (PC) or cntrl-clicking (Mac) displays a contextual menu, which also gives the option to ‘Expand 

ALL’ or ‘Collapse ALL’ the albums and songs within ALL the albums in a source view.  
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Playlist View  

The Playlist View allows the user the option to create, view and add songs to playlists.  

 

   
In the default perspective, the Playlists view is on the right-most middle section of the perspective window 

and can be closed using the x and accessed from under the ‘Window’ menu, using the ‘Show view’ menu 

item.  To create a new playlist, use the ‘Edit’ menu, ‘Create a New Playlist’ menu item.  Double-clicking 

on the playlist title, will display the songs listed in that playlist, just as clicking on the ‘+’ (PC Version) 

or  (Mac Version) will do.  Double-clicking on the song title will activate playing of that song. When 

that song is completed the next song in the playlist will begin until all songs are played or stopped.  Right 

clicking (PC) or ‘cntrl clicking’ (Mac) on a playlist album brings up the contextual menu that allows the 

user to ‘Play/Delete’ the playlist  or ‘Create a new playlist’, “Expand All’ or ‘Collapse All’ the playlists 

and ‘Grab Search Results’ to add to an existing or newly created playlist.   A dialog box displays the 

progress information while ‘Grabbing’ search results and adding them to the playlist.   Note:  the ‘Grab 

Search Results’option in contextual menu is only available after doing a search. 

 

Volume View  

The Volume View allows the user the option to adjust volume by using the up/down arrow or by typing 

in a value in the volume text box.  The option to put piano into Quiet Mode (where the mechanical piano 

action of playing the keys on the piano is disabled) is accomplished by checking the box.  If headphones 

are plugged into the piano, that will also be represented, but the option to change that doesn’t exist (you 

must disconnect the headphones from the piano).  Clicking on the ‘Volume’ button in the Volume View 

is a shortcut to bringing up the ‘Volume Details’ view. 

 

     
 

Repeat Mode View 

The Repeat Mode View allows options of repeating one song, an entire album, and also randomly 

playing an all songs in an album or all songs from a specific source.  Note that when playing all songs from 

a specific source, DKVBrowser is controlling which song gets chosen next.  Therefore, choosing “next 

song” from any other location (the piano itself, another instance of DKVBrowser running on another 

computer, the handheld remote, etc.) will cause the piano to play the next song in the current album.  
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However, when that song finishes, DKVBrowser will again take over and chose a random song from the 

same source. 

    
The Repeat Mode View provides support for all repeat modes when playing Albums.  Click on the option 

buttons. 

• Off - repeat mode is off 

• One - repeats one song over and over 

• Entire Album - repeats all songs in the current album  

• Source Random - This feature doesn't exist inside the piano.  If you are in this mode and you try 

to use the ‘next’ button  from the piano PRC or tablet, or from another remote it will simply move 

on to the next song (not random).  Randomness only happens if the song gets all the way to the 

end, or if you click ‘next’ in DKVBrowser.  This also means that it only works if DKVBrowser is 

left running.  Furthermore, if DKVBrowser is currently randomizing all songs in the ‘user’ source, 

and you double click on a ‘pianosoft’ song, you will have switched to playing random songs in the 

‘pianosoft’ source. 

• Album Random - plays all of the songs in the current album in a random order 
 

Now Playing View 

The Now Playing View displays the current song playing (or cued up to play) as well as the source and 

album title, the playbar (indicating current position within the song), buttons for accessing previous, next, 

pause, stop and play options. 

  
In the default perspective, the Now Playing View is on the top right section of the perspective window and 

can be closed using the x and accessed from under the ‘Window’ menu, using the ‘Show view’ menu item.  

The source name, album title and song title are displayed above the playbar.   The user can click inside 

the playbar or use the arrows on the right side of the playbar, to skip to another section of the song, advance 

or replay a section of the song.  The length of the song and the elapsed time of the song playing are 

displayed.   User can use the various buttons to play a song previous to this song in an album or playlist, 

pause the song, stop the song, resume playing the song, or go to the next song in the album or playlist.   

Clicking the ‘Find’ button highlights the currently loaded or playing song in the ‘Source’ view 

window.   Be sure to clear all search results by using the ‘Clear’ button in Search view window before 

using the ‘Find’ option to highlight the song.  The "autoFind" mode, which can be activated by selecting 

the ‘Auto’ button, makes DKVBrowser track the currently playing song. This could get annoying if you are 

working with the Browser interactively, so it's easy to turn on and off.  Its state will be remembered if you 

close DKVBrowser.
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Search View 

The Search View allows searching for songs or albums by options:  any, album title, song title, 

comments, filename and rating or any combination.   The ‘Clear’ button will allow ALL the albums and 

songs to show up under the Source View. 

   
    

The default options for the search are:  album title, song title, song comment, and file name.  However, 

you can limit the search, by deselecting ‘any’ and selecting one or more of the categories.  Type in the 

word or words (contiguous), that you wish to search for, and click on ‘Search’ button to execute the 

search.  You can enter upper or lower case in the search. If you are looking for Willie Nelson songs, just 

enter ‘willie nelson’ and click on ‘search’ button.   The search result is a list of albums or songs in bold 

type that contain the matching word(s).  The album may not have the search words in the title, but if you 

click on the ‘+’  (PC Version) or (Mac Version) to open the album, you will see the songs listed which 

match the search criteria and words.  To search by rating, click on the box next to the word rating and 

select the asterisk from pull down menu.  The results will be all songs that have a rating that are greater 

than or equal to the number of asterisks chosen from the pull down box.   The number of search results 

that meet the search criteria will be displayed next to the word ‘Count’ to the right of the ‘clear’ button. 

Details View 

The Details View displays comments, date, filename, last played date, length of song, play count, 

rating, song number, and title of song or album.  Titles, comments, and ratings can be edited in this 

view.  It has been noted that the piano is not always accurate about some of these fields, especially song 

length, and last played date. 
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Note:  There are two other views not in the default or initial screen that are described below: 

A/B Repeat View 

The A/B Repeat View, (which is NOT in the default layout), is accessed from ‘Show View’ under the 

‘Window’ menubar.  If you wish, you can save this customizable perspective by using the ‘Save 

Perspective As’ menu item under the ‘Window’ menubar. 

       
The A/B Repeat View gives the ability to repeat a segment of a song by setting various options and 

details: 

• Begin button - click on the beginning time segment of the song 

• End - click on the ending time of the segment of the song 

• Once - repeats the segment of the song once  

• Continuous - repeats the segment of the song continuously until paused or set to off. 

• Off - turn the repeat option off 

• Play - plays the current segment of the song for the number of repeats one or continual 
• Pause - pauses the currently playing segment of the song 
• Reset - resets the current settings back to previous setting 

 

Volumes Detail View 

The Volume Details View (which is NOT in the default layout), is accessed from ‘Show View’ under the 

‘Window’ menubar.  If you wish you can save this customizable perspective, by using the ‘Save 

Perspective As’ menu item in the ‘Window’ menubar.  As mentioned above, there is a shortcut to this view 

in the regular ‘Volume’ view, (just click on the ‘Volume’ button). 

     
The Volume Details View allows the user to adjust the volume for four types of volumes on the piano.  

User can move the slider or use up/down arrows or type in a value to adjust the various volumes for: 

• Voice - volume of the digital piano sound that you play on the keyboard in Quiet/Headphone 

mode. 

• Tone Generator - volume of the ensemble sound reproduced by the tone generator 

• Audio - CD volume 

• Microphone - volume of sound input from the microphone 
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Song Options View 

The Song Options View is accessed from ‘Song Options’ tab next to the ‘Details’ View in the default 

window or from the ‘Show View’ menu option in ‘Windows’ pull down menu.  It can be moved to a 

customized location.    

     
The Song Options View can only operate on the currently loaded or playing song. The song title that 

you are affecting with this view is the one that is showing in the Now Playing View, and it is also listed in 

the Song Options View as well.     

• Piano Part Ch L:  Selects the desired channel (01) thru (16) to which you assign the left-hand 

part or not using ##. 

• Piano Part Ch R:  Selects the desired channel (01) thru (16) to which you assign the right-hand 

part or not using ##. 

• Piano Velocity Curve:  In acoustic mode, the loud notes may get distorted when you  play a 

MIDI song designed not for acoustic piano playback, but for a certain instrument voice.  In such a 

case, you can automatically adjust only the volume of the acoustic piano part moderately without 

changing the volume of the other parts.  Select the desired acoustic piano volume (Soft 85) thru 

(Soft 20), or Select (Thru) to inactivate this function. 

• Main Volume Adjust:  Adjusts the overall volume. 

• Audio Volume Adjust:  Adjusts the volume of the accompaniment or standard audio sound pre-

recorded on the software CD’s. 

• Audio Pitch Adjust:  Adjusts the pitch of the accompaniment or standard audio sound pre-

recorded on the software CD’s. 

• Skip:  Sets the song to be played (Off) or not (On) during playback a series of songs in an album. 

• Guide:  Turns the SmartKey function on (ON) or off (OFF). When ON is selected, you can set the 

on/off setting of the SmartKey function respectively for each part (L) or (R).  Note:  The 

SmartKey guide option is automatically set to ON when SmartKey song is played.  See page 35 of 

advanced Mark IV manual. 

Note:   From the Source view the user can use the cntrl click (Mac) or right click (PC) to bring up the 

contextual menu option ‘Load’ for a song.  This allows the user to ‘load’ after stopping the currently 

playing song, without playing a song when using the ‘Song Options’ view. 
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Metronome View 

The Metronome View is accessed from ‘Show Views’ menu option in the ‘Windows’ pull down menu.  It 

will appear next the ‘Detail View’ as a tab, but can be moved to a customized location. 

    
The beats of the metronome help you play the Disklavier with a steady tempo. The tempo, the meter (beat), 

and the volume of the click can be adjusted, by using the arrows to the right or by using the slider or typing 

in a value in the textbox next to the item you wish to change.   Note: The [Tempo] value indicates the 

number of beats in a minute, and one beat represents a quarter note. When you play a song written in 

different measure unit, convert the unit to quarter note (e.g. When playing a song in 3/2, set [Beat] to 6/4).   

To start the metronome, click on the ‘Turn On’ button.  To stop, click on the ‘Turn Off’ button. Tap on the 

‘Reset’ button to resume the default tempo.  Note that clicking on the reset button, changes only the tempo 

value. 

 

Tempo/Transpose View 

The Tempo/Transpose View is accessed from ‘Show Views’ menu option in the ‘Windows’ pull down 

menu.  It will appear next the ‘Detail View’ as a tab, but can be moved to a customized location.  Tap on 

the small left and right arrows to the right of the slide bar to adjust the tempo value of the currently playing 

song.  To resume the original tempo tap on ‘reset’ button.  The adjusted value appears in the text box below 

the slider bar.  The value can be adjusted from -50% to +20% in 1% increments.  Use the small arrows or 

slider bar to adjust the transposition value.  This value is shown in the textbox below the slider bar.  The 

‘reset’ button sets the value to 0.  The song can be temporarily transposed in half step keys up or down two 

octaves (-24 to +24). 
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Song Tracks View 

The Song Tracks View is accessed from ‘Show Views’ menu option in the ‘Windows’ pull down menu.  It 

will appear next the ‘Detail View’ as a tab, but can be moved to a customized location.   This screen 

displays the track information.  Tap on the small down arrow to the right of the track number to edit in the 

track list.  The voice list screen will appear with a choice of 512 voices.  Tap on the desired voice name or 

type in a number in the textbox.   
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Menus 

Edit 

 

   
 

• Create New Album/ Playlist menu item - Allows user to create new album/playlist. 

• Delete menu item - Allows the user the option to delete a song, album or playlist. 

• Export menu item - Prompts user for a filename and location to store a report of the albums and 

songs on the Mark IV Disklavier sources.   The report is exported in an Excel spreadsheet type 

format.  The names of source, albums, songs, comments, rating, play count, date, last played date 

and length of songs are exported, as well as the header info for each of these items saved to the 

spreadsheet.  The user may also save a spreadsheet of search results.  Note: song may not have a 

length until played. 

 

  
 

• Refresh PC tab menu item - Allows the user to update the current list of songs/albums under the 

PC tab source, that otherwise does not auto-refresh (unless you are dragging and dropping into this 

view in DKVBrowser). 

• Put Piano Into Standby menu item - There is now a preference to automatically wake the piano 

on launch (and reconnect after the computer wakes from standby). It defaults to "true" so that 

DKVBrowser continues to act as it always did.  You can set the option to be turned off so that it 

doesn't wake the piano. Here's why nearly EVERYTHING you might want to do with 

DKVBrowser works while the piano is still in standby. There is a significant power savings to 
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leaving the piano in standby. It turns out that pretty much the only thing the piano needs to be 

woken up for is to actually "PLAY" music.  So, if you want to use DKVBrowser for *anything* 

else, such as editing titles, rearranging things, searching, adding to playlists, exporting, etc, then 

there' s no reason to wake the piano. If you ever want to wake the piano from DKVBrowser (or 

put it into standby) there is a new menu item in the "Edit" menu for doing so. DKVBrowser also 

won't ask you if you want to put the piano into standby upon exit if the piano is already in standby. 

One thing to be aware of is that while the piano is in standby, no operations can be done on any of 

the "removable" media...so floppies, CDs, and USB drives will not appear in DKVBrowser even if 

they are mounted.         

  

• Exit (PC version File Menu) - Prompts the user for option to put the Disklavier in standby mode 

upon quitting DKVBrowser software.  Cancel ignores the quitting request.   Note:  The Mac user 

can exit, using the ‘quit’ menu item under the’ DKVBrowser’ menu or by clicking on the red close 

button in the upper left corner of the perspective window.  The user will be given the opportunity 

to put the Disklavier in standby or not.  DKV Browser will not offer this option if you have already 

put the disklavier piano in standby mode.       

    

Window   

• Open Perspective menu item - Allows the user to click on ‘other’ and access saved customized or 

default perspectives.          

  
• Show View menu item - Allows the user to access the various views:  A/B Repeat, Details, Now 

Playing, Playlists, Repeat Mode, Search, Volume, Volume Details and to place them by drag/drop 

methods to customize their perspective.    

• Save Perspective As menu item - Allows the user to save their customized perspective.  
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• Reset Perspective menu item - Allows the user to reset the Perspective to the default view. 

• Preferences menu item - Allows the user to enter the corresponding piano IP address or hostname 

for his disklavier, to test the connection, to restore default setting, and/or apply this preference so 

that the DKVBrowser can communicate over the network with the Disklavier Mark IV using this 

preference.  The DKVBrowser attempts to auto-connect, but if user experiences problems 

connecting the first time to the piano, check the trouble-shooting section for helps and tips.  A 

check box is provided in the Preference Window that allows the user to change the default auto-

pause feature of DKVBrowser. Another check box option allows the user to wake the piano from 

standby if required.   ‘Guest Mode’ option via checkbox to allow users to play songs, but restricts 

editing of files is also available.  You will need a password to turn this feature off, once you have 

turned it on and left the Preferences Window. The password is "DKVBrowser", no quotes, case 

sensitive.  Don't forget it, or you will be in Guest mode until you re-install. The password is only 

required if you are already in guest mode, and are trying to turn it off.  To get to that point, turn on 

guest mode and click OK (or Apply) and then leave the preferences dialog (even cancel will work 

if you hit Apply).  You are now in guest mode.  If you then go back to preferences, and try to turn 

off Guest mode, the password field should become available.      

    

Help   

 

    
 

• About menu item - Shows the name, author and current version of the software, as well as 

plug-in and configuration details that show information about the modules/plug-ins used for 

creating this software.  Web Links are also provided for the user’s groups for disklavier, 

DKVBrowser software and SourgeForce where community discussions and updates are posted. 
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Quick Tips  

View and Play Songs within Playlists and Albums 

• Click on the ‘+’ (PC Version) or (Mac Version) beside a playlist or album to expand it.  This will 

display the songs in the album or playlist.   

• Double-click on album title also displays or expands to song titles. 

• To play a song, double-click on the song. 

• You can stop the song, or pause it using the controls in the Now Playing view. 

• Next and Prev advance to the next or previous song in the playlist or album and can be accessed in the 

Now Playing view. 

• When a song finishes playing, the next song in the list will begin. 

Note:  Playing audio songs may not do what you expect. If you play them directly you only get the CD 

sound.  

Display All Albums 

• To view all songs and albums on the Mark IV Disklavier sources, set the search category to ‘any’  

• Set the search field to blank  

• Click on ‘search’ button. 

• Or, just click on the ‘Clear’ button in the Search View. 

Note:  The albums will be displayed in the Source View.    

Play all songs in a playlist 

• Click on the ‘+’ (PC Version) or (Mac Version) beside a playlist to expand it.  This will display the 

songs in the playlist.  Double-clicking on the playlist title also displays or expands to song titles. 

• Double-clicking on the first song title will activate playing of that song.  When that song is completed 

the next song in the playlist will begin until all songs are played or stopped.    

Note:  If a playlist refers to a song that is not currently available (maybe it was on a USB device that was 

disconnected) the piano will stop playing at the missing song and you will not get an error message. 

Rename a song or album or playlist 

• Select the song or album or playlist. 

• Press F2 

• Edit the name, press Enter (PC Version) or Return (Mac Version) or click off that field 

• Or, click on the title in the ‘Details’ view and edit the name.  This will change the title in the 

‘Source’ view also. 

Note: Renaming only works on PianoSoft, User and CD library. 

Updating the Comments field 

• Select the song or album. 

• Double-click in the comments column next to the song.   

• Enter the comments, press Enter (PC Version) or Return (Mac Version) or click off that field. 

• Or, click on the comment field in the Details view and enter the comment changes.  This will 

change the comments in the ‘Source’ view also.

Note: Editing Comments only works on PianoSoft, User and CD library. 
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Updating the Ratings field 

• Select the song or album. 

• Double-click in the ratings column next to the song 

• A drop down list of ratings will appear 

• Click on the asterisk rating you want.  

• Press enter or return or click off of the ratings field 

Note:  Updating only works on PianoSoft, User and CD sources. 

 

Revising Albums and Playlists 

Move 

To move a song from one album to another album or from one playlist to another playlist, just click on the 

song (the song name and details will be highlighted in gray).  Drag it to the new album either in the same 

source or another source or to a playlist.   As you drag the song over the name of the album (playlist), the 

album (playlist) should expand to reveal the list of songs in that album (playlist).  A horizontal line will 

appear in the place where you wish to drop this song.  Be patient as the command is performed.  The song 

name should appear in the spot where the horizontal line appeared    Note:  Move is the default operation 

for dragging.  See below if you want to copy.   

Copy 

To copy a song from one album or playlist to another, hold down the ctrl key (PC Version) while dragging. 

The icon will indicate copy.  If you are on the Mac, hold down the option key while you are dragging.  

Note:  To copy a song from an album to a playlist, just drag it from the album to the playlist.  It will remain 

in the album, and be added to the playlist. 

Delete  

Delete works for albums, songs within albums, playlists, and songs within playlists. 

 

PC Users: 

Select the song, album or playlist you wish to delete and press the Delete key or right click on the song 

and select ‘delete’.  Or, you can select ‘delete’ from the Edit menu.  You will be prompted ‘if you really 

want to delete’ or given option to cancel the delete. 

 

Mac Users: 

Select song or album or playlist to delete and cntrl click on the song and select ‘delete’.  Or, you can select 

‘delete’ from the Edit menu.  You will be prompted ‘if you really want to delete’ or given option to cancel 

the delete. 
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Create New Albums and Playlists 

Note:  There are some sources for which creating an album is not supported by the piano.   

Create a New Album 

You can add a new album to source views or tabs.  To add an album, you can select ‘Create a new Album’ 

from the ‘Edit’ menu or just right click (PC) or control-click (Mac) under the appropriate tab.  A new 

album will appear as “New Album” on the bottom of the list.  The next operation would typically be to 

select the album name and rename using F2. 

  

Create a New Playlist 

To add a playlist, right click (PC) or cntrl click (Mac) on the Playlist view window or select ‘Create a 

New Playlist’ under the ‘Edit’ menu.  A new playlist will be inserted as a “New Playlist” title, and will 

appear at the bottom of the list of playlists.  The next operation would typically be to select the playlist 

name and rename using F2, and then copying songs into the album or playlist by dragging and dropping 

them from the albums to the new playlist.  These songs can be moved in the order you wish by using the 

drag/drop techniques. 

      
    
Note:  The user can also use the right click (PC) or cntrl click (Mac) option on the Playlist view window to use the 

option ‘Grab Search Results’ to add songs to a newly created playlist or existing playlist.  The user can 

play/load/find/delete a song selected in a playlist, as well as expand/collapse the list of songs in a playlist. 

Adding Songs or Albums to the To/From PC tab 

Note:  User can use the method of mounting the To/From PC folder via wifi connection and move midi 

song files to the shared folder or can use the method described below: 

Drag and Drop Midi Songs or Albums between Hard Drive and PC tab 

You can add a new album or song to the To/From PC tab (‘PC’) in the ‘source’ view of DKVBrowser.  

Merely drag and drop the song from your hard drive over the first icon in the PC tab.  Single files, 

multiple files, or entire folders (including sub folders) can be dragged to the ‘PC’ tab.  The destination of 

the dropped file or files is indicated in DKVBrowser with a horizontal bar.  Note that unlike all other drag 

and drop operations in DKVBrowser, the absolute position (or order) is not being indicated, just the 

destination album.  Also note that the piano does not display nested folders as you might imagine, but they 

are still supported.   Likewise, songs and albums can be dragged from DKVBrowser’s ‘PC’ tab to your 

hard drive, desktop, etc.  
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Customizing Perspective 
Note:  The user can customize the perspective for DKVBrowser by drag/drop techniques, tear-off, 

minimize, maximize, deleting a view or combinations as he wishes.   The views that are available are 

selected from the Window menu under the Show view menu option.  When the user quits the DKVBrowser 

program in a normal manner, his latest perspective will be the perspective that appears on the display 

when he reopens DKVBrowser.  The user also has the option to save and open saved and default 

perspectives under the Window menu.  Performing customization through dragging and dropping may take 

some practice for Mac users. 

Dragging and Dropping Views 

To move a view, the user must select the view window he wishes to move to a new location.  Note: the tab 

will be highlighted in medium gray.  This is the area that you need to click on to move this view.  Drag the 

view to the area of the perspective that you wish to drop.  But remember, that you must observe the arrow 

icon as it changes in form to one of three icons:  tabbed folders, horizontal bar with arrow pointing 

up/down, or a vertical bar with arrow pointing left/right.  These indicators will specify what will occur, 

when you drop this view onto another view.   

 

Option:  When the arrow icon is a tabbed folder, the view that is dragged will be dropped as a tab next to 

the view under it.  (See figure below:  User dragged the A/B Repeat view over the Details View and 

dropped the A/B Repeat View onto the Details View when the arrow icon was indicating tabbed folders.) 

    
Option:  When the arrow icon is a horizontal bar with arrow pointing up/down, the view is placed either 

above or below the view under it.   (See figure below:  User dragged the A/B Repeat view over the Repeat 

Mode view and dropped the A/B Repeat view under the Repeat Mode view.) 
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Option:  When the arrow icon is a vertical bar with arrow pointing right/left, the view is placed either to 

the right or left of the view under it before the drop.  (See figure below:  User dragged the A/B Repeat view 

over the Repeat Mode view and dropped the A/B Repeat view to the right of the Repeat Mode view.) 

    

Minimizing, Maximizing and Deleting Views 

     
To minimize a view, the user must click the minimize icon (2

nd
 icon in image above).  The view will 

disappear from the perspective and a narrow column will appear under the red quit button with icons that 

represent multiple or single view in the perspective window.  To view the minimized view as a single view, 

click on the larger icon.  To see all the views click on the multiple icons. 

 

To maximize a view, the user must click the maximize icon (3
rd

 icon in image above).  This will cause all 

the other views to minimize into the narrow column on the left side of the perspective and maximize the 

one view to the full perspective window.  Clicking on the various icons on the narrow column will cause 

different views to maximize in the perspective window (using the single icon) or cause the multiple views 

to all reappear. 

 

To delete a view, click on the X icon (1
st
 icon in image above).  This will cause the view to disappear from 

the perspective window and the user can access this view back by clicking on the Window menu and 

selecting ‘Show View’ menu item and selecting the view that you wish to access. 
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 Resizing Views or Fields or Perspective 

     
To resize a view, the user should move the cursor over the section, until the cursor turns into a cross-hair 

shaped cursor.  The user can then lengthen or shorten the view window that is adjacent to the cross-hair 

shaped cursor.   

 

 Note:  the user also has the capability of using these same cross-hair cursors to resize the comment, 

rating, and filename fields in the source view.  The user can grab the right lower corner of the perspective 

window and adjust the size of the perspective or the user can use the green button in the upper left corner 

to maximize the perspective or if clicked again toggle back to the previous size.  The yellow button in the 

upper left corner of the perspective will minimize the perspective and to maximize the window back to 

original size, click on the minimized perspective icon. 

Tear-off Views 

To tear-off a view, the user should click on the icon or gray shaded area of the selected view and drag it 

outside of the perspective onto the user’s desktop.  It will become a window all unto itself.  To return it to 

the perspective, select the window by clicking on the icon or gray area and dragging it back to the area 

where you would like to position it within the perspective and drop it according to tab, right/left or up/down 

position icons.    

 

Tray Icon (PC Version) or Status Icon in Menu Bar (Mac Version) 

The Tray Icon (On PC) or Status Icon (Mac) appears in the upper right menu bar.  Often a user likes to 

minimize DKVBrowser and ignore it from then on.  But occasionally when a song comes on that the user 

might want to skip, instead of expanding DKVBrowser to use it to skip that song and then minimize it 

again, the tray or status icon, can be accessed as a contextual menu using cntrl click (Mac) or right click 

(PC) which allows the user to play, stop, move to the next song, or quit DKVBrowser. The tray icon or 

status icon also displays the current song and album and source titles via a balloon when a new song loads.  

If the user clicks on the status or tray icon it will display the current song that is loaded and/or playing. 
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Trouble-Shooting and Feedback 
 

Visit our Yahoo group at http://launch.groups.yahoo.com/group/dkvbrowser/ 

 

Q:  When you use the 'song search' on the Virtual PRC, the virtual PRC will play all the songs in the list of 

songs that meet that search criteria.   I can’t get my DKVBrowser to do the same. 

A:  The DKVBrowser will not do the same thing.   The search in DKVBrowser does not work the same 

way as the Virtual PRC.  The reason DKVBrowser doesn't move onto the next song is quite simply that it is 

playing the search result from its original location.  In fact, it does play the next song, but that isn't the next 

song in the search results, it's the next song in whatever album that song is in.  Note:  You can try making a 

temporary playlist of the search results and play from the playlist.     The option to ‘Grab Search Results’ to 

add these songs to a newly created playlist or existing playlist provides a quick way to create this playlist.  

This option can be found in the contextual menu that is shown when cntrl click (Mac) or right click (PC) is 

used in the Playlist view after a search is performed. 

 

Q:  The creation date in the ‘Details’ view seems to be incorrect. 

A:   A bug report has been sent to Yamaha noting that the piano forgets the "creation date” when a song is 

copied from one album to another.  It is not being kept correctly in the Virtual PRC or PRC device either.  

Otherwise, creation dates should be accurate. 

 

Q:  When renaming a song on the Virtual PRC, it does not show up on the DKV window except in tabs 

other than the PC tab and only when I use the 'clear' button to refresh the windows or tabs.    

A:  Certain operations are performed directly on the database.  These include changing the song name, 

setting comments and ratings, and possibly others.  When you do those operations, the piano doesn’t 

actually know about it, and it isn’t communicated over the protocol that the piano uses to talk to all of the 

devices that may be controlling it.  Therefore, you must “refresh” everything.  The simplest way to do this 

in DKVBrowser is by clicking on the ‘Clear’ button in the ‘Search’ view. 

 

Q:  I am getting a message that DKVBrowser is not able to connect with my piano, what can I do? 

A:  DKVBrowser attempts to initialize (auto-discover) and connect with the Disklavier Mark IV 

automatically.  When you turn on your computer/wake it from standby, or when the piano has recently 

switched from standby/on/off there is a period of time where all computers on the network are negotiating 

and announcing what they make available over the network.  In particular, the piano seems to be pretty 

slow about announcing itself to other computers on the network.  Fortunately, this only affects the auto-

discovery in DKVBrowser, and once discovered, the IP address is stored in the ‘Preference’ for later use.   

If you have problems connecting initially, try quitting and relaunching the DKVBrowser app again.   If that 

doesn’t seem to work, it is suggested to manually wake the Disklavier and then relaunching DKVBrowser 

again. 

 

Q:  I seem to be having a problem, moving and copying albums, songs and playlists. Do you have any 

suggestions or comments that might assist me? 

A: Here's a bit of documentation about dragging albums from one source to another. When you are re-

ordering albums within a source, you've probably noticed that there is an indicator that shows up between 

albums to clue you into the final position of the dragged album.  When you are dragging an album to a 

different source, there is a subtle difference.  You should notice that the indicator is either above an album, 

below an album, or not displayed at all (highlighting the album you are currently over).  What this is 

indicating is that the album will be moved/copied above or below (when the indicator is there) or (instead) 

all of the songs from the source album will be copied *into* the destination album. This is the difference 

between the choices that the PRC-100 gives you (copy album, or copy all songs in album to another 

album).  DKVBrowser interprets the destination as a clue as to whether or not you want to copy the album, 

or the contents of the album.  Remember that the default is move not copy. Also, you should be prepared 
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for an error message if you try to move something which is protected to any external source (the piano will 

not allow that, as you might imagine).   

 

Q:  I am not able to click on an album name, song name or playlist name and edit it, what am I doing 

wrong? 

A:  Be sure to use the F2 key when clicking on the name of a song, album or playlist to edit in the ‘Source’ 

and ‘Playlist’ views.  You can also change these names in the ‘Details’ view with a simple selection of the 

name without using the F2 key.  The name changes will be retained in the ‘Source’ and ‘Playlist’ views. 

 

Q:  Do I need to stop playing a song to do a search? 

A:  No, it is not necessary to stop playing a song to do a search.  Unlike the PRC-100, searches can be 

performed while the piano is playing.  For other operations, DKVBrowser has the ability to auto-pause, and 

this can be turned off in the preferences window. 

 

Q:  How can I find the ‘source’ and album for a song in my playlist? 

A:  Click on the song in the playlist and then view the ‘Details’ view for this information, or choose ‘Find’ 

from the context menu of the playlist song. 

 

Q:  Sometimes I am playing a song and do a search for other songs while that song is playing and I want to 

see the info for that file and its ‘source’ and album info, how can I do this? 

A:  You can click on the ‘Clear’ button in the ‘Search’ view in order to clear the current search results in 

the ‘Source’ view and then click on the ‘Find’ button in the ‘Now Playing’ view and this should highlight 

the song playing and show the info in the ‘Source’ view. 

 

Q:  Am I able to drag songs that are on a floppy, CD or USB thumb drive to a playlist?   

A:  It is NOT recommended dragging songs from your USB/Floppy or CD tab to the playlists.  It's mostly 

harmless, but there is a good chance that you will remove the USB drive (or floppy, or CD) at some point 

in the future, and the playlist is NOT a copy of the song, it's a pointer to the song in it's original place.  So, 

if you want songs from your USB device in a playlist, you should probably drag them to the User tab first, 

and then create a playlist from the User tab.  The PRC-100 doesn’t allow dragging songs from removable 

media to playlists for this very reason. 

 

Q: Where is the Refresh button?  

A: To refresh or view all the albums and songs, just click on the ‘Clear’ button in the ‘Search view’ 

window. To refresh midis and albums in the PC tab, use the ‘Refresh PC tab in the Edit menu’ or the option 

to ‘Refresh PC Tab in the contextual menu’ that is accessed via right-clicking (PC) or cntrl clicking 

(Mac) in the PC tab window. 
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Appendix I – Installation and Network Information 
 

Overview 

 

This section is divided into Mac and PC, since these are the main platforms we have tested on. 

Installation 

Your system is required to have a java runtime environment installed.  Most computers already have 

one since it is required by many things.  You should try to use DKVBrowser as described and only 

return here if you find that it doesn’t work.   Verify that you have the java runtime environment (JRE) 

installed. You can do this by going to http://www.java.com/en/download/help/testvm.xml.  You should 

see something like this image if it is installed. 

 

 If it is not installed, download it from http://www.java.com/en/download/manual.jsp. 

PC  

 

Download the zip file from sourceforge.net, and unzip it into the desired directory.  Double click on 

DKVBrowser.exe. 

Mac 

 

Download the zip file from sourceforge.net to the desktop.  Double click to unzip it.  Drag 

DKVBrowser.app to the applications folder.  This is normally all that is required. 

Execution 

Virtual PRC 

If you have version 3.0 or greater of the Disklavier software, then you have the option to install the Virtual 

PRC.  If you have installed it, you are given the option to enable the Virtual PRC.  If you have checked the 

box to enable it, then you will be able to run DKVBrowser from the Disklavier in standby.  Otherwise, you 

will have to turn on the Disklavier before running. The following image is from the setup of the Virtual 

PRC, discussed in the Yamaha instructions. 
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PC Startup 

If your Disklavier is not connected to your network through the Ethernet port, then you must connect to the 

Disklavier through wireless:  Select the wireless connection by Start/Connect to/Wireless Connection.  

Then choose “View Wireless Networks”.  Select the Disklavier by double clicking on it (shown as 

DKV2207F4 in the following screen shot).  
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To run DKVBrowser: Locate the DKVBrowser.exe file and double click on it.  

  

If you see the following message, check to see that your piano is in standby or on (not off) and that you 

have set up the network correctly.   

Mac Startup 

 

1. Wireless:  From Airport at the top of the screen, choose the Disklavier wireless 
2. Wired: DKVBrowser will attempt to automatically locate the piano, but it is helpful to know the 

disklavier name (preferred and easiest method) or the IP address.  There are at least two ways to 

find the IP address, documented here for completeness, but are not necessary.  Use the 

DKV#####, where # are numbers in the name.   

a) From Terminal (in utilities), enter, without the quotes, “smbutil lookup dkvnnnnex”, putting 

in your Disklavier name.  If you have not enabled the Virtual PRC, the Disklavier will have to 

be on. 

b) By running the Virtual PRC.  The first window that comes up will have the IP address.   

3. Double click on DKVBrowser in the Applications folder. 
DKVBrowser will store the last name or IP used.  If your IP address is dynamically assigned, and changes, 

you will have to find the new address, and will be given a preference window to change it in DKVBrowser. 
 

Note: during the process of creating the documentation, we had an issue with the Disklavier not showing in 

the Mac finder window for up to an hour after turning it on.  We found that we could connect using the 

Go/Server menus in the finder, and inputting smb://IP address.  You then login as Guest. This is not 

necessary for DKVBrowser, but might come in handy when accessing the to/from PC folders.   

Note (if running wirelessly) 

 

Just because you are able to use the Disklavier radio and see the To/From PC folder does not mean you are 

able to run DKVBrowser wirelessly.  On many wireless setups, the computer can access either the Internet 

and house network, or the Disklavier wireless network, but not both at the same time.  Once you get things 

configured, it will be easy to switch back and forth, but the first time it may require some trial and error, 

and patience. 

Summary 

You can connect to the piano wirelessly (192.168.88.1), or wired (IP address assigned by your network).  

In all cases, the name of the piano on the network can be substituted (and should be).  It looks like 

DKV555ABC.  If you have turned the "Virtual PRC" feature off on a Disklavier running 3.0 or later, you 

will not be able to wake the Disklavier from standby by any means other than manually pressing the button 

on the Disklavier itself." 
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Sample Startup Screens 

 


